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Question Shuffling Allowed : Yes
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Question Number : 1 Question Id : 2549896418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The ______ list contains programs that accomplish a variety of tasks commonly required on a computer. Most of these programs are
installed with the Windows 7 operating system, such as Calculator, Snipping Tool and WordPad.
Options :
1.  Helper programs
2.  Necessities
3.  Utilities
4.  Accessories
  
Question Number : 1 Question Id : 2549896418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
___________ सूची म� वे �ो�ाम होते ह� जो आमतौर पर कं�ूटर पर आव�क िविभ� �कार के काय� को पूरा करते ह�। इनम� से अिधकतर �ो�ाम
Windows 7 ऑपरेिटंग िस�म, जैसे कैलकुलेटर, ि�िपंग टूल और वड�पैड के साथ इं�ाल िकये जाते ह�।
Options :
1.  हे�र �ो�ाम
2.  नेसेिसटीज़
3.  यूिटिलटीज़
4.  ए�ेसरीज
  
Question Number : 2 Question Id : 2549898415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which function in MS Excel 2007 returns the individual term binomial distribution probability?
Options :
1.  BINOM.DIST function
2.  PBINOM.DIST function
3.  BINOMDIST function
4.  BINOM.DISTP function
  
Question Number : 2 Question Id : 2549898415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Excel 2007 का कौन सा फं�न अलग-अलग पदो ंकी ि�पद िवतरण संभा�ता देता है?
Options :
1.  BINOM.DIST फं�न
2.  PBINOM.DIST फं�न
3.  BINOMDIST फं�न
4.  BINOM.DISTP फं�न
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Question Number : 3 Question Id : 2549899310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following keys is referred to as toggle key on a computer keyboard?
Options :
1.  Num lock
2.  Shift
3.  Alt
4.  Control
  
Question Number : 3 Question Id : 2549899310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर की-बोड� की िन� म� से िकस की को टॉगल की के �प म� जाना जाता है ?
Options :
1.  Num lock (नम लॉक)
2.  Shift (िश�)
3.  Alt (अ�)
4.  Control (कंट� ोल)
  
Question Number : 4 Question Id : 25498911801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a modulo operator in C language?
Options :
1.  %
2.  |
3.  \
4.  )
  
Question Number : 4 Question Id : 25498911801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, C भाषा म� एक मो�ुलो ऑपरेटर है?
Options :
1.  %
2.  |
3.  \
4.  )
  
Question Number : 5 Question Id : 25498920527 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A _____________ can be converted into an electronic form and stored in a computer as one or more files.
Options :
1.  wizard
2.  document
3.  pane
4.  device
  
Question Number : 5 Question Id : 25498920527 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
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_________ को इले�� ॉिनक �प म� प�रवित�त िकया जा सकता है और कं�ूटर म� एक या अिधक फाइलो ंके �प म� सेव िकया जा सकता है।
Options :
1.  िवज़ाड�
2.  डॉ�ूम�ट
3.  पैन
4.  िडवाइस
  
Question Number : 6 Question Id : 25498920569 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The physical parts of a computer that you can touch and see are called ______________.
Options :
1.  hardware
2.  software
3.  virtual memory
4.  operating system
  
Question Number : 6 Question Id : 25498920569 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर के वे भाग �ा कहलाते ह� िज�� भौितक �प से छुआ या देखा जा सकता है?
Options :
1.  हाड�वेयर
2.  सॉ�वेयर
3.  वचु�अल मेमोरी
4.  ऑपरेिटंग िस�म
  
Question Number : 7 Question Id : 25498924749 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The ______ command in UNIX is an enhanced communication program.
Options :
1.  talk
2.  pwd
3.  read
4.  who
  
Question Number : 7 Question Id : 25498924749 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
यूिन� (UNIX) म� मौजूद ______ कमांड एक उ�त संचार �ो�ाम है।
Options :
1.  talk
2.  pwd
3.  read
4.  who
  
Question Number : 8 Question Id : 25498929729 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In which of the following memories, not separate bytes but blocks of bytes are being erased at the same time?
Options :
1.  Programmable Read Only Memory
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2.  Erasable Read Only Memory
3.  Electrically Erasable Read Only Memory
4.  Flash Memory
  
Question Number : 8 Question Id : 25498929729 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकस मेमोरी म� अलग-अलग बाइट्स नही ंब�� बाइट्स के �ॉक एक ही समय म� इरेज़ िकये जाते ह�?
Options :
1.  �ो�ामेबल रीड ओनली मेमोरी
2.  इरेजेबल रीड ओनली मेमोरी
3.  िवद्युत �प से इरेज़ेबल रीड ओनली मेमोरी
4.  �ैश मेमोरी
  
Question Number : 9 Question Id : 25498929893 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In which of the following tabs in MS Word 2016 are formatting tasks like bolding, italicising and changing the font style and size found?
Options :
1.  Page Layout
2.  Insert
3.  Home
4.  References
  
Question Number : 9 Question Id : 25498929893 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2016 के िन�िल�खत म� से िकस टैब म� बो�, इटैिलक करने और फ़ॉ� �ाइल तथा आकार बदलने जैसे फॉम��िटंग टा� मौजूद होते ह�?
Options :
1.  पेज ले-आउट
2.  इंसट�
3.  होम
4.  रेफेर�स
  
Question Number : 10 Question Id : 25498929975 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following refers to criminally presenting artificial replications of a piece of biometric data to the biometric system in order to
try and gain access?
Options :
1.  Biometric scanning
2.  Biometric spying
3.  Biometric spoofing
4.  Biometric scoring
  
Question Number : 10 Question Id : 25498929975 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा िवक� उस आपरािधक कृ� को संदिभ�त करता है िजसके अंतग�त बायोमेिट� क डेटा के िकसी भाग की नकल बनाकर बायोमेिट� क तं�
म� �वेश का �यास िकया जाता है?
Options :
1.  बायोमेिट� क �ैिनंग
2.  बायोमेिट� क �ाइंग
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3.  बायोमेिट� क �ूिफंग
4.  बायोमेिट� क �ो�रंग
  
Question Number : 11 Question Id : 25498931266 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In computing, the specification of a motherboard, such as shape and size, is called ______.
Options :
1.  case factor
2.  features
3.  form factor
4.  chipset factor
  
Question Number : 11 Question Id : 25498931266 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूिटंग म�, मदरबोड� के िववरण जैसे िक आकृित और आकार ______ कहलाते ह�।
Options :
1.  केस फै�र
2.  फीचस�
3.  फॉम� फै�र
4.  िचपसेट फै�र
  
Question Number : 12 Question Id : 25498931330 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the data transfer rate of USB 3.1?
Options :
1.  10 Gbps
2.  5 Gbps
3.  480 Mbps
4.  12 Mbps
  
Question Number : 12 Question Id : 25498931330 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
USB 3.1 की डेटा �थानांतरण दर �ा है?
Options :
1.  10 Gbps
2.  5 Gbps
3.  480 Mbps
4.  12 Mbps
  
Question Number : 13 Question Id : 25498933055 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A graphic tablet is also known as:
Options :
1.  a book-pad
2.  a puck
3.  a pen tablet
4.  a pantograph
  



06/03/2023, 12:16

7/38

Question Number : 13 Question Id : 25498933055 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
�ािफ़क टैबलेट को िकस अ� नाम से भी जाना जाता है?
Options :
1.  बुक-पैड
2.  पक
3.  पेन टै�ेट
4.  प�टो�ाफ़
  
Question Number : 14 Question Id : 25498933182 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The word 'bit' is a short form of ______.
Options :
1.  binary nibble
2.  binary digit
3.  binary word
4.  binary byte
  
Question Number : 14 Question Id : 25498933182 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
'िबट' श� ______ का संि�� नाम है।
Options :
1.  बाइनरी िनबल
2.  बाइनरी सं�ा
3.  बाइनरी श�
4.  बाइनरी बाइट
  
Question Number : 15 Question Id : 25498933937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a display method that causes a portion of the display to appear like a negative of the regular display?
Options :
1.  Pixel
2.  Reverse video
3.  Touch screen
4.  Cursor
  
Question Number : 15 Question Id : 25498933937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सी वह िड��े िविध है िजसके कारण िड��े का एक भाग सामा� िड��े के नेगेिटव के जैसा िदखाई देता है?
Options :
1.  िप�ेल
2.  �रवस� वीिडयो
3.  टच-�ीन
4.  कस�र
  
Question Number : 16 Question Id : 2549898180 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
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_________ occurs when an attacker uses an email message to trick a recipient into thinking it came from a known and/or trusted source.
Options :
1.  Website spoofing
2.  Email spoofing
3.  IP spoofing
4.  ARP spoofing
  
Question Number : 16 Question Id : 2549898180 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
_________ तब होता है जब कोई हमलावर िकसी ईमेल संदेश का उपयोग करके िकसी ईमेल-�ा�कता� की इस �कार ठगी करता है िक वह मान ल� िक
यह �ात तथा/या िव�सनीय �ोत से आया है।
Options :
1.  वेबसाईट �ूिफ़ंग
2.  ईमेल �ूिफ़ंग
3.  IP �ूिफ़ंग
4.  ARP �ूिफ़ंग
  
Question Number : 17 Question Id : 2549899475 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Monochrome laser printer uses ___________ toner cartridges.
Options :
1.  white
2.  black
3.  grey
4.  RGB
  
Question Number : 17 Question Id : 2549899475 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
मोनो�ोम लेज़र ि�ंटर ___________ टोनर कािट� �ज का उपयोग करता है।
Options :
1.  सफ़ेद
2.  काली
3.  �े
4.  RGB
  
Question Number : 18 Question Id : 2549899490 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
If you want to change the page size of the Word Document while printing then the correct option is:
Options :
1.  File->Print->Page size
2.  File->Print->Properties->Finishing
3.  File->Print->Properties->Page Source
4.  File->Print->Properties->Quality
  
Question Number : 18 Question Id : 2549899490 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
यिद आप ि�ंट करते समय वड� डॉ�ूम�ट का पेज साइज़ सेट करना चाहते ह�, तो सही िवक� �ा है?
Options :
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1.  फ़ाइल->ि�ंट->पेज साइज़
2.  फ़ाइल->ि�ंट->�ॉपट�स->िफिनिशंग
3.  फ़ाइल->ि�ंट->�ॉपट�स->पेज सोस�
4.  फ़ाइल->ि�ंट->�ॉपट�स->�ािलटी
  
Question Number : 19 Question Id : 2549899597 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
With reference to printing pages, PDL stands for:
Options :
1.  Page Drafting Language
2.  Page Definition Language
3.  Page Description Language
4.  Page Design Language
  
Question Number : 19 Question Id : 2549899597 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
पृ�ो ंके ि�ंिटंग के संदभ� म�, PDL का पूण� �प �ा है?
Options :
1.  Page Drafting Language (पेज ड� ा��ंग ल��ेज)
2.  Page Definition Language (पेज डेिफिनशन ल��ेज)
3.  Page Description Language (पेज िड���शन ल��ेज)
4.  Page Design Language (पेज िडजाईन ल��ेज)
  
Question Number : 20 Question Id : 25498910797 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ are also called internal fonts for a printer.
Options :
1.  Soft fonts
2.  Hard fonts
3.  Both soft fonts and hard fonts
4.  Resident fonts
  
Question Number : 20 Question Id : 25498910797 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
________ को ि�ंटर के िलए आंत�रक फॉ� भी कहा जाता है।
Options :
1.  सॉ� फॉ�
2.  हाड� फॉ�
3.  सॉ� फॉ� और हाड� फॉ� दोनों
4.  रेसीड�ट फॉ�
  
Question Number : 21 Question Id : 25498911260 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
With reference to wireless communication frequencies, the frequency range of 300 KHz to 3000 KHz is known as:
Options :
1.  low frequency
2.  medium frequency
3.  high frequency
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4.  very high frequency
  
Question Number : 21 Question Id : 25498911260 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
बेतार संचार (wireless communication) आवृि�यो ंके संदभ� म�, 300 KHz से 3000 KHz की आवृि� र�ज को ______ के �प म� जाना जाता है।
Options :
1.  िन� आवृि�
2.  म�म आवृि�
3.  उ� आवृि�
4.  अित उ� आवृि�
  
Question Number : 22 Question Id : 25498913409 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Image ___________ is a random variation of brightness or colour information in the images captured. 
Options :
1.  blast
2.  sound
3.  noise
4.  voice
  
Question Number : 22 Question Id : 25498913409 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
इमेज ___________, कै�चर की गई इमेज म� शु�ता (�ाइटनेस) या रंग जानकारी का एक या���क प�रवत�न है।
Options :
1.  �ा�
2.  साउंड
3.  नॉइज़
4.  वोइस
  
Question Number : 23 Question Id : 25498913469 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a guided data transmission media?
Options :
1.  Radio wave
2.  Microwave
3.  Satellite
4.  Optical Fiber
  
Question Number : 23 Question Id : 25498913469 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, एक िनद� �िशत डेटा ट� ांसिमशन मीिडया है?
Options :
1.  रेिडयो तरंग
2.  माइ�ोवेव
3.  उप�ह (सैटेलाईट)
4.  ऑि�कल फाइबर
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Question Number : 24 Question Id : 25498918493 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What are the steps to print the test page in Windows 10?
Options :
1.  My computer->Printer and Devices->select printer->right click to see Properties-> click on ‘Print Test Page’ button
2.  Home->Printer and Devices->select printer->right click to see Properties-> click on ‘Print Test Page’ button
3.  Control panel->Devices and Printers->select printer->right click to see Printer Properties-> click on ‘Print Test Page’ button
4.  Control panel->Printer and Devices->select printer->right click to see Properties-> Page Source->click on ‘Print Test Page’ button
  
Question Number : 24 Question Id : 25498918493 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िवंडोज 10 म� टे� पेज (test page) को ि�ंट करने के िलए �ा चरण ह�?
Options :
1.  My computer (माइ क��ुटर)->printer and devices (ि�ंटर और िडवाइस)-> printer चयन करे-> properties देखने के िलए राइट ��क करे->
‘print test page’ बटन पर ��क करे।
2.  Home (होम)->printer and devices (ि�ंटर और िडवाइस)-> printer चयन करे-> properties देखने के िलए राइट ��क करे-> ‘print test page’
बटन पर ��क करे।
3.  Control panel (कंट� ोल पैनल)->printer and devices (ि�ंटर और िडवाइस)-> printer चयन करे-> properties देखने के िलए राइट ��क करे->
‘print test page’ बटन पर ��क।
4.  Control panel (कंट� ोल पैनल)->printer and devices (ि�ंटर और िडवाइस)-> printer चयन करे-> properties देखने के िलए राइट ��क करे->
page source(पेज सोस�)-> ‘print test page’ बटन पर ��क।
  
Question Number : 25 Question Id : 25498918579 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What does IPv4 stand for?
Options :
1.  Internet Protocol version 4
2.  Internet Protocol verification 4
3.  Internet Product version 4
4.  Internet Protocol validation 4
  
Question Number : 25 Question Id : 25498918579 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
IPv4 का पूण� �प �ा है?
Options :
1.  Internet Protocol version 4 (इंटरनेट �ोटोकॉल वज़�न 4)
2.  Internet Protocol verification 4 (इंटरनेट �ोटोकॉल वे�रिफकेशन 4)
3.  Internet Product version 4 (इंटरनेट �ोड� वज़�न 4)
4.  Internet Protocol validation 4 (इंटरनेट �ोटोकॉल वैिलडेशन 4)
  
Question Number : 26 Question Id : 25498920746 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
With reference to web interface logs, which log displays start and end of each sessions?
Options :
1.  Traffic log
2.  System log
3.  Threat log
4.  Unified log
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Question Number : 26 Question Id : 25498920746 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वेब इंटरफेस लॉग के संदभ� म�, कौन-सा लॉग ��ेक स� के �ारंभ और अंत को �दिश�त करता है?
Options :
1.  ट� ै िफक लॉग
2.  िस�म लॉग
3.  �ेट लॉग
4.  यूिनफाइड लॉग
  
Question Number : 27 Question Id : 25498922036 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
KRACK attacks can be prevented by ________.
Options :
1.  changing the parts of the code responsible for UDP handshake
2.  changing the parts of the code responsible for TCP handshake
3.  changing the parts of the code responsible for HTTP handshake
4.  changing the parts of the code responsible for WPA2 handshake
  
Question Number : 27 Question Id : 25498922036 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
KRACK अटैक को िकसके �ारा रोका जा सकता है?
Options :
1.  यू.डी.पी. (UDP) ह�डशेक के िलए िज�ेदार कोड के िह�ो ंको बदलकर
2.  टी.सी.पी. (TCP) ह�डशेक के िलए िज�ेदार कोड के िह�ो ंको बदलकर
3.  एच.टी.टी.पी. (HTTP) ह�डशेक के िलए िज�ेदार कोड के िह�ो ंको बदलकर
4.  ड�ू.पी.ए.2 (WPA2) ह�डशेक के िलए िज़�ेदार कोड के िह�ो ंको बदलकर
  
Question Number : 28 Question Id : 25498924025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the keyboard shortcut to lock the screen in Windows?
Options :
1.  Window Key + O
2.  Window Key + S
3.  Window Key + L
4.  Window Key + M
  
Question Number : 28 Question Id : 25498924025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िवंडोज़ म� �ीन लॉक करने के िलए कीबोड� शॉट�कट �ा है?
Options :
1.  Window कंुजी + O
2.  Window कंुजी + S
3.  Window कंुजी + L
4.  Window कंुजी + M
  
Question Number : 29 Question Id : 25498924179 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
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Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a real time operating system?
Options :
1.  VxWorks
2.  Window CE
3.  RT Linux
4.  PalmOS
  
Question Number : 29 Question Id : 25498924179 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सी, एक रीयल टाइम ऑपरेिटंग िस�म नही ंहै?
Options :
1.  VxWorks
2.  Window CE
3.  RT Linux
4.  PalmOS
  
Question Number : 30 Question Id : 25498925415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In offline UPS system, in the event of mains failure:
Options :
1.  transfer switch connects the power line and the inverter to the load
2.  transfer switch disconnects the inverter line
3.  transfer switch disconnects the power line and connects the inverter to the load
4.  transfer switch disconnects the inverter and connects the power line to the load
  
Question Number : 30 Question Id : 25498925415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ऑफ़लाइन UPS िस�म म�, मेईन िवफलता (mains failure) की ��थित म� �ा होता है?
Options :
1.  ट� ांसफर ��च पावर लाइन और इ�ट�र को लोड से जोड़ता है।
2.  ट� ांसफर ��च इ�ट�र लाइन को िड�ने� करता है।
3.  ट� ांसफर ��च पावर लाइन को िड�ने� करता है और इ�ट�र को लोड से जोड़ता है।
4.  ट� ांसफर ��च इ�ट�र को िड�ने� करता है और पावर लाइन को लोड से जोड़ता है।
  
Question Number : 31 Question Id : 2549896768 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Bookmarks or favourites folders in web browsers are primarily used for:
Options :
1.  forwarding email messages
2.  capturing screens
3.  saving web URLs
4.  restoring files and folders
  
Question Number : 31 Question Id : 2549896768 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वेब �ाउज़रो ंम� बुकमा�� और फेवरेट्स फो�स� का उपयोग मु�तः  िकसिलए िकया जाता है?
Options :



06/03/2023, 12:16

14/38

1.  ईमेल मैसेज फॉरवड� करने के िलए
2.  �ी� को कै�चर करने के िलए
3.  वेब URL को सेव करने के िलए
4.  फाइल और फो�रो ंको �र�ोर करने के िलए
  
Question Number : 32 Question Id : 2549897208 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The font size of 36 points in MS Word is equal to _____ inches.
Options :
1.  0.125
2.  0.25
3.  0.5
4.  1
  
Question Number : 32 Question Id : 2549897208 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word म� 36 पॉइंट का फॉ� साइज _____ इंच के बराबर होता है।
Options :
1.  0.125
2.  0.25
3.  0.5
4.  1
  
Question Number : 33 Question Id : 2549897431 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following options is NOT available in the Insert tab of MS Word 2019?
Options :
1.  Shapes
2.  Table
3.  Graph
4.  Shading
  
Question Number : 33 Question Id : 2549897431 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 के इंसट� टैब म� िन� म� से कौन सा िवक� उपल� नही ंहोता है?
Options :
1.  शे�
2.  टेबल
3.  �ाफ
4.  शेिडंग
  
Question Number : 34 Question Id : 2549897765 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Internet users are connected to the ______ of the desired ISP.
Options :
1.  gateway
2.  hard disk
3.  hub
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4.  track
  
Question Number : 34 Question Id : 2549897765 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
इंटरनेट उपयोगकता� वांिछत ISP के _________ से जुड़े �ए होते ह�।
Options :
1.  गेटवे
2.  हाड� िड�
3.  हब
4.  ट� ैक
  
Question Number : 35 Question Id : 2549897932 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid email address?
Options :
1.  email.@domain.com
2.  email@domain.com
3.  1234567890@domain.com
4.  _______@domain.com
  
Question Number : 35 Question Id : 2549897932 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा एक वैध ई-मेल एड� ेस नही ंहै?
Options :
1.  email.@domain.com
2.  email@domain.com
3.  1234567890@domain.com
4.  _______@domain.com
  
Question Number : 36 Question Id : 25498910500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Identify the correct check box option under When Correcting Spelling in MS Office programs in Proofing options of MS Word 2016.
Options :
1.  Ignore words in UPPERCASE
2.  Ignore words in Lowercase
3.  Ignore words in UPPERCASE and symbols
4.  Ignore words in Lowercase and symbols
  
Question Number : 36 Question Id : 25498910500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2016 म� �ूिफंग िवक�ो ंके MS ऑिफस �ो�ा� म� '�ेन करे��ंग �ेिलंग' के तहत सही चेक बॉ� िवक� की पहचान कर�।
Options :
1.  अपरकेस म� श�ो ंको अनदेखा कर�
2.  लोअरकेस म� श�ो ंको अनदेखा कर�
3.  अपरकेस और �तीको ंम� श�ो ंको अनदेखा कर�
4.  लोअरकेस और �तीको ंम� श�ो ंको अनदेखा कर�
  
Question Number : 37 Question Id : 25498910541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
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Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following margin styles is most preferable to draft a business document in MS Word?
Options :
1.  Normal
2.  Moderate
3.  Narrow
4.  Mirrored
  
Question Number : 37 Question Id : 25498910541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word म� िबजनेस डॉ�ूम�ट का ड� ा� तैयार करने के िलए िन�िल�खत म� से कौन सा मािज�न �ाइल सबसे बेहतर होता है?
Options :
1.  नॉम�ल
2.  मॉडरेट
3.  नैरो
4.  िमररड�
  
Question Number : 38 Question Id : 25498910574 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  first
2.  middle
3.  last
4.  second
  
Question Number : 38 Question Id : 25498910574 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  �थम
2.  म�
3.  अंितम
4.  ि�तीय
  
Question Number : 39 Question Id : 25498910593 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Identify the option that arrange the given steps in the correct sequence to apply an indent in MS Word.
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a) Click the top triangle of the indent marker
b) Move it to where you want the first line indent to be positioned
c) To apply the first line indent
Options :
1.  c, a, b
2.  b, a, c
3.  b,c,a
4.  a,c,b
  
Question Number : 39 Question Id : 25498910593 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word म� इंड�ट लागू करने के िलए िदए गए चरणो ंको सही �म म� �व��थत करने वाले िवक� की पहचान कर�। 

a) इंड�ट माक� र के सबसे ऊपरी ि�भुज पर ��क कर�  
b) इसे वहां पर ले जाएं जहां आप फ�� लाइन इंड�ट लगाना चाहते ह�
c) फ�� लाइन इंड�ट लगाने के िलए
Options :
1.  c, a, b
2.  b, a, c
3.  b,c,a
4.  a,c,b
  
Question Number : 40 Question Id : 25498910621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a method of accessing fixed internet for home or office?
Options :
1.  Mobile broadband
2.  Asymmetric Digital Subscriber Line
3.  Public Wi-Fi
4.  Private Wi-Fi
  
Question Number : 40 Question Id : 25498910621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
घर या काया�लय म� लगे �थायी इंटरनेट के ए�ेस का तरीका िन� म� से �ा है?
Options :
1.  मोबाइल �ॉडब�ड
2.  असमिमत (Asymmetric) िडिजटल स��ाइबर लाइन
3.  साव�जिनक वाई-फाई
4.  �ै��क वाई-फाई
  
Question Number : 41 Question Id : 25498910688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  Next page
2.  Continuous
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3.  Even page
4.  Odd page
  
Question Number : 41 Question Id : 25498910688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  ने� पेज
2.  कंटी�ूअस
3.  इवेन पेज
4.  ऑड पेज
  
Question Number : 42 Question Id : 25498910719 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following Find options in MS Word 2019 would you select to find words that look alike, but when spelled, are different?
Options :
1.  Sounds like
2.  Match case
3.  Find whole words only
4.  Find all word forms
  
Question Number : 42 Question Id : 25498910719 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 म�, िभ� वत�नी लेिकन एक समान िदखने वाले श�ो ंको खोजने के िलए आप िकस फाइंड िवक� का उपयोग कर� गे?
Options :
1.  साउंड लाइक
2.  मैच केस
3.  फाइंड �ोल वड� ओनली
4.  फाइंड ऑल वड� फॉ��
  
Question Number : 43 Question Id : 25498911501 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Identify the option that arranges the given steps in the correct sequence to turn off the capitalisation of names of days feature.

a) Make sure the AutoCorrect tab is displayed.
b) Choose AutoCorrect Options from the Tools menu. Word displays the AutoCorrect dialog box
c) Click on OK.
d) Clear the 'Capitalize names of days' check box.
Options :
1.  b, a, d, c
2.  b, a, c, d
3.  b, d, a, c
4.  b, c, d, a
  
Question Number : 43 Question Id : 25498911501 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
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Correct Marks : 1 Wrong Marks : 0
िदनो ंके नाम कैिपटलाइज़ करने की सुिवधा को बंद करने के िभ� चरण यहां िदए गए ह�। इन चरणो ंके �व��थत �म वाले िवक� का चयन कर�।

a) सुिनि�त कर�  िक ऑटो करे� टैब �दिश�त हो रहा है।

b) टू� मेनू से ऑटो करे� िवक� चुन�। Word ऑटो करे� डायलॉग बॉ� �दिश�त करता है

c) OK पर ��क कर�।

d) 'िदनो ंके नाम कैिपटलाइज़ कर� ' चेक बॉ� को ��यर कर�।
Options :
1.  b, a, d, c
2.  b, a, c, d
3.  b, d, a, c
4.  b, c, d, a
  
Question Number : 44 Question Id : 25498911878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which option of 'Display for Review' in the Review tab in MS Word 2013 shows the final version with in-line mark-ups?
Options :
1.  All Mark-up
2.  No Mark-up
3.  Original
4.  Simple Mark-up
  
Question Number : 44 Question Id : 25498911878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2013 म� �र�ू टैब के 'िड��े फॉर �र�ू' का िन� म� से कौन सा िवक� इन-लाइन माक� -अप के साथ अंितम सं�रण को दशा�ता है?
Options :
1.  आल माक� -अप
2.  नो माक� -अप
3.  ओ�रिजनल
4.  िसंपल माक� -अप
  
Question Number : 45 Question Id : 25498912488 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following can be used to insert a quick calendar in MS Word 2019?
Options :
1.  Quick Calendar
2.  Quick Table
3.  Insert Table
4.  Insert Calendar
  
Question Number : 45 Question Id : 25498912488 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 म� ��क कैल�डर इंसट� करने के िलए िन� म� से िकसका उपयोग िकया जा सकता है?
Options :
1.  ��क कैल�डर
2.  ��क टेबल
3.  इंसट� टेबल
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4.  इंसट� कैल�डर
  
Question Number : 46 Question Id : 25498919193 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In the Mail Merge process, while adding address block in MS Word 2016, under Specify Address Elements in the Insert Address block
dialogue box, there is/are ____ option(s).
Options :
1.  1
2.  2
3.  3
4.  4
  
Question Number : 46 Question Id : 25498919193 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2016 म� मेल मज� �ि�या के दौरान एड� ेस �ॉक जोड़ते समय, 'इंसट� एड� ेस �ॉक' डायलॉग बॉ� म� 'एड� ेस एिलम�ट्स िनिद�� कर� ' के तहत
____ िवक� मौजूद होते ह�।
Options :
1.  1
2.  2
3.  3
4.  4
  
Question Number : 47 Question Id : 25498920600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Google Chrome, Mozilla Firefox, Internet Explorer and Netscape Navigator are examples of:
Options :
1.  web servers
2.  web browsers
3.  internet
4.  world wide web
  
Question Number : 47 Question Id : 25498920600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
गूगल �ोम, मोिज़ला फायरफॉ�, इंटरनेट ए�ोरर, नेट�ेप नेिवगेटर, ये सभी िकसके उदाहरण ह�?
Options :
1.  वेब सव�र के
2.  वेब �ाउज़र के
3.  इंटरनेट के
4.  व�� वाइड वेब के
  
Question Number : 48 Question Id : 25498925304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The Quick Access Tool bar is located at the top left corner of the ______ in MS Word 2019.
Options :
1.  Menu Bar
2.  Status Bar
3.  Title Bar
4.  Tool Bar
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Question Number : 48 Question Id : 25498925304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 म� ______ के ऊपरी बाएं कोने म� ��क ए�ेस टूलबार ��थत होता है।
Options :
1.  मेनू बार
2.  �ेटस बार
3.  टाइटल बार
4.  टूल बार
  
Question Number : 49 Question Id : 25498925310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following methods is used to quickly open an earlier opened document in MS Word 2019?
Options :
1.  Open the folder -> Select the file
2.  Close the MS Word program -> Reopen the Word program
3.  Go to File -> Go to Recent documents -> Click on document
4.  Click on the quick access tool bar
  
Question Number : 49 Question Id : 25498925310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 म� पहले से खोले गए डॉ�ूम�ट को ज�ी से खोलने के िलए िन� म� से िकस िविध का उपयोग िकया जाता है?
Options :
1.  फ़ो�र खोल� -> फ़ाइल का चयन कर�
2.  MS Word �ो�ाम बंद कर�  -> वड� �ो�ाम को िफर से खोल�
3.  फाइल पर जाएं -> रीस�ट डा�ूम�ट्स पर जाएं -> डा�ूम�ट्स पर ��क कर�
4.  ��क ए� सेस टूल बार पर ��क कर�
  
Question Number : 50 Question Id : 25498925486 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts will help you save your MS Word document while you are working on it?
Options :
1.  Ctrl + S
2.  Alt + S
3.  Shift + S
4.  Insert + S
  
Question Number : 50 Question Id : 25498925486 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
जब आप अपने MS Word डॉ�ूम�ट पर काम कर रहे हो,ं तो िन� म� से कौन सा की-बोड� शॉट�कट आपको अपने डॉ�ूम�ट को सेव करने म� सहायता
करेगा?
Options :
1.  Ctrl + S
2.  Alt + S
3.  Shift + S
4.  Insert + S
  
Question Number : 51 Question Id : 25498925506 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
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Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
For which of the following symbols or words can a superscript or subscript in MS Word 2019 NOT be used?
Options :
1.  Trademark
2.  Copyright
3.  Standard abbreviation
4.  Exponent
  
Question Number : 51 Question Id : 25498925506 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2019 म�, िन�िल�खत म� से िकस �तीक या श� के िलए सुपर��� या सब��� का उपयोग नही ंिकया जा सकता है?
Options :
1.  ट� ेडमाक�
2.  कॉपीराइट
3.  मानक सं�ेपों
4.  घातांक
  
Question Number : 52 Question Id : 25498933755 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a central location of various web pages that are all related?
Options :
1.  Website
2.  Web browser
3.  Search engine
4.  Web host
  
Question Number : 52 Question Id : 25498933755 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
आपस म� संबंिधत सभी वेब पेजो ंका एक क� �ीय �थान िन� म� से कौन सा है?
Options :
1.  वेबसाइट
2.  वेब �ाउज़र
3.  सच� इंजन
4.  वेब हो�
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Question Shuffling Allowed : No
Is Section Default? : null
  
Question Id : 25498921199 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix Calculator : None Response Time : N.A Think Time : N.A Minimum
Instruction Time : 0
Question Numbers : (53 to 57)
Read the given passage and answer the questions.
Edison
When it is dark, we simply press a switch and the electric bulb gives us light. Do you know who invented the electric bulb? He was an
American named Thomas Alva Edison. Even in his childhood, Edison loved to conduct experiments. With his pocket money, he set up a
small laboratory. His parents encouraged him and helped him in his experiments.

After some time, Edison needed more money to carry on his experiments. So, he decided to take up a job in the railways. He was only
twelve years old at that time. Edison became a newspaper boy and travelled up and down the train to Detroit. He sold newspapers, sweets,
fruits and earned two dollars on the first day.

“Take this dollar, mother. Every night I will give you a dollar from what I earn.” And he kept his promise. A year or two later, Edison
decided to produce his own newspaper. He bought an old printing press and set it up in his railway wagon. He sold a number of copies of
his paper and made more money. With the money he set up a small laboratory in his wagon. When he was fifteen, he met with an accident.
While he was doing an experiment in the laboratory, the train turned round a corner. There was a sudden jolt and a bit of phosphorus fell on
the floor of the wagon and it caught fire. The fire spread and Edison shouted for help. The guard came in and together they were able to put
out the fire. But that was the end of Edison’s services on the train.

But, Edison didn’t give up his experiments and made a series of inventions. In 1878, he began work on an electric lamp. People used
candles and oil lamps in those days. He promised to give them light in two years. Other scientists laughed at him. But he was undaunted.
He worked harder and harder. After one thousand and two hundred experiments, Edison succeeded in making the electric bulb. On New
Year’s Day in 1880, he and his workers put up electric lights in his laboratory. Edison had kept his promise to the people.
Sub questions
 
Question Number : 53 Question Id : 25498921200 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
This passage is mainly about Edison’s:
Options :
1.  early experiments
2.  passion for experiments
3.  invention of the electric bulb
4.  promises to people
 
Question Number : 54 Question Id : 25498921201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
When he was twelve, Edison earned money for his experiments by:
Options :
1.  delivering newspaper from house to house
2.  travelling on a train up and down to Detroit
3.  taking up a job selling things on a train
4.  selling sweets and fruit in the market
 
Question Number : 55 Question Id : 25498921202 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
To produce newspapers, Edison set up a printing press in his:
Options :
1.  railway wagon
2.  own house
3.  laboratory
4.  parents’ house
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Question Number : 56 Question Id : 25498921203 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Why did Edison’s job in the railway end?
Options :
1.  He had set up a laboratory in the wagon.
2.  He produced his own newspapers in the wagon.
3.  Some phosphorus fell due to a sudden jolt.
4.  A wagon caught fire because of him.
 
Question Number : 57 Question Id : 25498921204 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Other scientists laughed at Edison because:
Options :
1.  he started work on the electric bulb in 1878
2.  they thought he would give up his experiments
3.  he conducted one thousand and two hundred experiments
4.  they thought that his promise was impossible to fulfil
  
Question Id : 25498921199 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix Calculator : None Response Time : N.A Think Time : N.A Minimum
Instruction Time : 0
Question Numbers : (53 to 57)
िदए गए ग�ांश को पढ़�  और उसके आधार पर ��ो ंके उ�र द�।

एिडसन
जब अंधेरा होता है, तो हम केवल एक ��च दबाते ह� और इले��� क ब� हम� रोशनी देता है। �ा आपको पता है िक इले��� क ब� का आिव�ार
िकसने िकया था? थॉमस ए�ा एिडसन नामक एक अमरीकी ने इसका आिव�ार िकया था। बचपन से ही एिडसन को िव�ान संबंधी परी�ण
(ए�पे�रम�ट्स) करना ब�त पसंद था। अपने जेब खच� से उ�ों�न ेएक छोटी सी �योगशाला �थािपत की थी। उनके माता-िपता ने उनको �ो�ािहत िकया
और उनके �ारा िकए जाने वाले परी�णो ंम� उनकी सहायता की।

कुछ समय बाद, एिडसन को अपनी जांच परी�ण जारी रखने हेतु और अिधक धन की आव�कता पड़ी। इसिलए उ�ों�न,े रेलवे म� नौकरी करने का
िनण�य िलया। उस समय उनकी उ� केवल 12 वष� की थी। एडीसन, समाचारप� डालने वाला लड़का बन गए और रेलगाड़ी से डेट� ॉयट आने-जाने लगे।
उ�ों�न ेसमाचारप�, िमठाइयां, फल बेचकर पहले िदन ही 2 डॉलर कमाया।

“माँ, यह डॉलर ले लो। हर रात म� अपनी कमाई से आपको 1 डॉलर दंूगा।” और उ�ों�न ेअपनी �ित�ा कायम रखी। एक अथवा दो वष� के बाद, एिडसन ने
अपने िनजी समाचार प� के उ�ादन का िनण�य िलया। उ�ों�न ेएक पुराना ि�ंिटंग �ेस खरीदा और उसे अपनी रेलगाड़ी के िड�े म� �थािपत िकया। उ�ों�ने
अपने समाचार प� की कई �ितयां बेची ंऔर अिधक धन कमाया। इस धन से उ�ों�न ेअपनी रेलगाड़ी के िड�े म� एक छोटी �योगशाला �थािपत की।
15 वष� की आयु म�, वे दुघ�टना�� �ए। �योगशाला म� परी�ण करते समय, रेलगाड़ी एक कोने से हो कर गुज़री। अचानक झटका लगने के कारण, थोड़ी
सी फॉ�ोरस रेलगाड़ी के िड�े के फश� पर िगरी और िफर आग लग गई। आग फैलने लगी और एिडसन सहायता मांगते �ए िच�ाने लगे। गाड़� के साथ
िमलकर वे आग को बुझाने म� कामयाब रहे। परंतु इससे, रेलगाड़ी म� एिडसन की सेवाओ ंका अंत हो गया।

परंतु एडीसन ने अपना परी�ण जारी रखा और कई आिव�ार िकए। वष� 1878 म�, उ�ों�न ेइले��� क ब� पर काय� करना शु� कर िदया। उन िदनो,ं
लोग मोमब�ी और तेल के िदयो ंका उपयोग िकया करते थे। उ�ों�न,े शपथ ली िक दो वष� म� उ�� रोशनी िदलाएंगे। अ� वै�ािनको ंने उनकी हँसी उड़ाई।
परंतु वे िवचिलत नही ं�ए। वे और अिधक मेहनत करते रहे। एक हज़ार दो सौ परी�णो ंके बाद, एिडसन को इले��� क ब� बनाने म� सफलता िमली। वष�
1880 म�, नव वष� के अवसर पर, उ�ों�न ेअपने कामगारो ंके साथ िमलकर �योगशाला म� इले��� क रोशनी जलाई। एिडसन ने लोगो ंसे िकए �ए वादे को
पूरा िकया।
Sub questions
 
Question Number : 53 Question Id : 25498921200 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
यह ग�ांश मु�तः  एिडसन के __________ के बारे म� है।
Options :
1.  �ारंिभक परी�ण (ए�पे�रम�ट)
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2.  परी�ण (ए�पे�रम�ट) से संबंिधत जुनून
3.  इले��� क ब� के आिव�ार
4.  लोगो ंसे िकए गए वादे
 
Question Number : 54 Question Id : 25498921201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
12 वष� की उ� म� एिडसन न� ______ अपने परी�ण (ए�पे�रम�ट) हेतु धन कमाया।
Options :
1.  घर-घर समाचारप� डालते �ए
2.  रेलगाड़ी से डेट� ायट तक आते-जाते �ए
3.  रेलवे म� व�ुओ ंकी िब�ी का काम करते �ए
4.  बाज़ार म� िमठाइयाँ और फलो ंकी िब�ी करते �ए
 
Question Number : 55 Question Id : 25498921202 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
समाचार-प�ो ंके उ�ादन हेतु, एिडसन ने अपने/अपनी ______ म� ि�ंिटंग �ेस �थािपत िकया।
Options :
1.  रेलगाड़ी के िड�े
2.  खुद के घर
3.  �योगशाला
4.  माता-िपता के घर
 
Question Number : 56 Question Id : 25498921203 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
रेलवे म� एिडसन की नौकरी का अंत �ो ं�आ?
Options :
1.  उ�ों�न,े रेल के िड�े म� �योगशाला �थािपत की थी।
2.  वे रेल के िड�े म� �त: के समाचारप� का उ�ादन करते थे।
3.  आक��क झटके से थोड़ी फॉ�ोरस िगर गई थी।
4.  रेल के िड�े म� उनके कारण आग लग गई थी।
 
Question Number : 57 Question Id : 25498921204 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
अ� वै�ािनक एिडसन की हँसी उड़ाया करते थे �ों�िक:
Options :
1.  एिडसन ने वष� 1878 म� इले��� क ब� पर काय� करना शु� िकया था।
2.  उ�ों�न ेसोचा िक वह अपना �योग करना छोड़ द�गे।
3.  एिडसन ने एक ह़ज़ार दो सौ परी�ण िकए थे।
4.  उनका िवचार था िक एिडसन का िकया �आ वादा, असंभव था।
  
  

QUANTITATIVE APTITUDE
Section Id : 2549897051
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
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Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897092
Question Shuffling Allowed : Yes
Is Section Default? : null
  
Question Number : 58 Question Id : 25498914321 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  250
2.  140
3.  180
4.  100
  
Question Number : 58 Question Id : 25498914321 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 59 Question Id : 25498928792 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The compound interest earned by Suresh on a certain amount at the end of two years at the rate of 8% p.a. was ₹1,414.40. What was the
total amount that Suresh got back at the end of two years in the form of principal plus interest earned?
Options :
1.  ₹9,414.40
2.  ₹9,914.40
3.  ₹9,014.40
4.  ₹8,914.40
  
Question Number : 59 Question Id : 25498928792 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
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Options :
1.  ₹9,414.40
2.  ₹9,914.40
3.  ₹9,014.40
4.  ₹8,914.40
  
Question Number : 60 Question Id : 25498928857 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498928857 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498929096 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  375
2.  340
3.  365
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4.  355
  
Question Number : 61 Question Id : 25498929096 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498929377 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A sum amounts to ₹9,680 in 2 years and to ₹10,648 in 3 years, interest compounded annually. The sum (in ₹) is:
Options :
1.  7800
2.  8000
3.  8400
4.  8500
  
Question Number : 62 Question Id : 25498929377 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498929666 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  



06/03/2023, 12:16

29/38

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498929666 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
  

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549897052
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897093
Question Shuffling Allowed : Yes
Is Section Default? : null
  
Question Number : 64 Question Id : 25498910061 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Among the following words, which one will come second if they are arranged as per their order in an English dictionary?
Options :
1.  Assistant
2.  Assessment
3.  Asbestos
4.  Asterisk
  
Question Number : 64 Question Id : 25498910061 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
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Correct Marks : 1 Wrong Marks : 0
चार श� िदये गये ह�। यिद सभी श�ो ंको अँ�ेजी श�कोश के अनुसार वणा�नु�म म� �व��थत िकया जाता है, तो दूसरे �थान पर कौन सा श� आयेगा?
Options :
1.  Assistant
2.  Assessment
3.  Asbestos
4.  Asterisk
  
Question Number : 65 Question Id : 25498914080 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Unscramble the letters in the words given in options, and find the odd one out.
Options :
1.  REAPP
2.  LIENCP
3.  RLTSAPE
4.  BAELT
  
Question Number : 65 Question Id : 25498914080 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िवक�ो ंम� िदए गए श�ो ंम� अ�रो ंको सुलझाय�, और िवषम श� को चुन�।
Options :
1.  REAPP
2.  LIENCP
3.  RLTSAPE
4.  BAELT
  
Question Number : 66 Question Id : 25498919673 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third number in the same way as the second number is related to the first number.

149 : 238 : : 159 : ?
Options :
1.  169
2.  248
3.  261
4.  268
  
Question Number : 66 Question Id : 25498919673 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
उस िवक� का चयन कर�  जो तीसरी सं�ा से ठीक उसी �कार संबंिधत है जैसे दूसरी सं�ा पहली सं�ा से संबंिधत है।

149 : 238 : : 159 : ?
Options :
1.  169
2.  248
3.  261
4.  268
  
Question Number : 67 Question Id : 25498919835 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
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Correct Marks : 1 Wrong Marks : 0
Four words have been given, out of which three are alike in some manner and one is different. Select the one that is different.
Options :
1.  Metre
2.  Furlong
3.  Yard
4.  Acre
  
Question Number : 67 Question Id : 25498919835 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
नीचे चार श� िदए गए ह� उनम� से तीन श� िकसी तरीके से एक-समान गुण वाले ह� लेिकन कोई एक चौथा श� उन तीन से िभ� है। उनम� िभ� (ऑड
वन) श� का पता लगाएं।
Options :
1.  मीटर
2.  फरलाँग
3.  गज
4.  एकड़
  
Question Number : 68 Question Id : 25498919842 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Four words have been given, out of which three are alike in some manner and one is different. Select the one that is different.
Options :
1.  Arrow
2.  Axe
3.  Knife
4.  Dagger
  
Question Number : 68 Question Id : 25498919842 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
नीचे चार श� िदए गए ह� उनम� से तीन श� िकसी तरीके से एक-समान गुण वाले ह� लेिकन कोई एक चौथा श� उन तीन से िभ� है। उनम� िभ� (ऑड
वन) श� का पता लगाएं।
Options :
1.  तीर
2.  कु�ाड़ी
3.  चाकू
4.  कटार
  
Question Number : 69 Question Id : 25498927371 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  16
2.  22
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3.  28
4.  32
  
Question Number : 69 Question Id : 25498927371 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  16
2.  22
3.  28
4.  32
  
  

GENERAL AWARENESS
Section Id : 2549897053
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897094
Question Shuffling Allowed : Yes
Is Section Default? : null
  
Question Number : 70 Question Id : 2549895298 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following religions did the early Vedic Aryans follow?
Options :
1.  Bhakti
2.  Image worship and Yajnas
3.  Worship of nature and Yajnas
4.  Worship of nature and Bhakti
  
Question Number : 70 Question Id : 2549895298 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वैिदक युग म� आय� िकस पूजा प�ित का पालन करते थे? 
Options :
1.  भ��
2.  मूित� पूजा और य�
3.  �कृित की पूजा और य�
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4.  �कृित की पूजा और भ��
  
Question Number : 71 Question Id : 2549899681 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
India's New Economic Policy announced on 24 July 1991 was known as the LPG or Liberalisation, Privatisation and Globalisation model
under________________________.
Options :
1.  the VP Singh led Government
2.  the Indira Gandhi led Government
3.  the Rajiv Gandhi led Government
4.  the PV Narasimha Rao led Government
  
Question Number : 71 Question Id : 2549899681 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
भारत की नई आिथ�क नीित की घोषणा 24 जुलाई 1991 को की गई थी, िजसे LPG अथवा उदारीकरण, िनजीकरण और वै�ीकरण मॉडल कहा गया। उस
समय क� � सरकार की बागडोर कौन संभाल रहा था?
Options :
1.  वीपी िसंह शािसत सरकार
2.  इंिदरा गांधी शािसत सरकार
3.  राजीव गांधी शािसत सरकार
4.  पीवी नरिस�ा राव शािसत सरकार
  
Question Number : 72 Question Id : 25498912551 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following gases is a supporter of combustion?
Options :
1.  Hydrogen
2.  Nitrogen
3.  Carbon dioxide
4.  Oxygen
  
Question Number : 72 Question Id : 25498912551 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सी गैस दहन म� सहायक होती है?
Options :
1.  हाइड� ोजन
2.  नाइट� ोजन
3.  काब�न डाइऑ�ाइड़
4.  ऑ�ीजन
  
Question Number : 73 Question Id : 25498929954 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Eskers are of glacio-fluvial origin. Which of the following statements characterises them?
Options :
1.  They are long, narrow and sinuous ridges of sand.
2.  They are small, irregular mounds of bedded sand.
3.  They are small alluvial terraces.
4.  They are flat-topped terraces.
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Question Number : 73 Question Id : 25498929954 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ए�र िहम�पी-नदी (�ैिशयो-�ूिवयल) मूल से संबंिधत ह�। इनम� से कौन सा कथन उनकी िवशेषता बताता है?
Options :
1.  ये रेत के लंबे, तंग और िशरानाल �रज ह�
2.  ये सं��रत रेत के छोटे, अिनयिमत उभार ह�
3.  ये छोटे जलोढ़ अ�र ह�
4.  ये सपाट-सतह अ�र ह�
  
Question Number : 74 Question Id : 25498936878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The Velikonda group of low hills is a part of:
Options :
1.  Cardamom Hills
2.  Western Ghats
3.  Eastern Ghats
4.  Nilgiri Hills
  
Question Number : 74 Question Id : 25498936878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िनचली पहािड़यो ंका वेिलकोडंा समूह, िन� म� से िकसका एक भाग है?
Options :
1.  कदा�मोम पहािड़यों
2.  पि�मी घाट
3.  पूव� घाट
4.  नीलिग�र पहािड़यों
  
Question Number : 75 Question Id : 25498937117 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The Coconut Triangle is located in:
Options :
1.  India
2.  Sri Lanka
3.  Bangladesh
4.  Maldives
  
Question Number : 75 Question Id : 25498937117 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कोकोनट ट� ाइएंगल (ना�रयल ि�कोण) कहां ��थत है?
Options :
1.  भारत
2.  �ीलंका
3.  बां�ादेश
4.  मालदीव
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English Mock
Group Number : 2
Group Id : 2549894472
Group Maximum Duration : 5
Group Minimum Duration : 5
Show Attended Group? : No
Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
Is this Group for Examiner? : No
Examiner permission : Cant View
Show Progress Bar? : No
  
  

English Mock
Section Id : 2549897054
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897095
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 76 Question Id : 25498941285 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children
have fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

English Actual
Group Number : 3
Group Id : 2549894473
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 3
Mandatory Break time : Yes
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Group Marks : 0
Is this Group for Examiner? : No
Examiner permission : Cant View
Show Progress Bar? : No
  
  

English Typing Test
Section Id : 2549897055
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897096
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 77 Question Id : 25498937919 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
Biodiversity is also called biological diversity. It is the variety of life found in a place on Earth or often the total variety of life on
Earth. A common measure of this variety called species richness is the count of species in an area. Biodiversity encompasses the
genetic variety within each species and the variety of ecosystems that species create. Although examining counts of species is
perhaps the most common method used to compare the biodiversity of various places in practice biodiversity is weighted
differently for different species. The count of animal species that live on land is much higher than the count of those that live in the
oceans because there are huge numbers of terrestrial insect species. Insects comprise many orders and families and they constitute
the largest class of arthropods which themselves constitute the largest animal phylum. In contrast there are fewer animal phyla in
terrestrial environments than in the oceans. No animal phylum is restricted to the land except a few and other animal phyla occur
exclusively or predominantly in marine habitats. Some species have no close relatives and exist alone in their genus whereas others
occur in genera made up of hundreds of species. Given this one can ask whether it is a species belonging to the former or latter
category which is very important. On one hand a taxonomically distinct species which is the only one in its genus or family for
instance may be more likely to be distinct biochemically and so be a valuable source for medicines simply because there is nothing
else quite like it. On the other hand although the only species in a genus carries more genetic novelty a species belonging to a large
genus might possess something of the evolutionary vitality that has led its genus to be so diverse. A second way to weight species
biodiversity is to recognize the unique biodiversity of those environments that contain few species but unusual ones. Dramatic
examples come from extreme environments such as the summits of active Antarctic volcanoes and hot springs or deep sea
hydrothermal vents. The numbers of species found in these places may be smaller than almost anywhere else yet the species are
quite distinctive. More generally areas differ in the biodiversity of species found only there. Species having relatively small ranges
are called endemic species. On remote oceanic islands almost all the native species are endemic. Endemic species are much more
vulnerable to human activity than are more widely distributed species because it is easier to destroy the entire habitat in a small
geographic range than in a large one. The idea of biodiversity also encompasses the range of ecological communities that species
form. A common approach to quantifying this type of diversity is to record the variety of ecological communities and area may
contain. It is generally accepted that an area having say both forests and prairies is more diverse than one with forests alone
because each of these assemblages is expected to house different species. This conclusion however indirectly based on differences in
vegetation structure or appearance rather than directly on lists of species. Loss of various biodiversities due to human intervention
is an alarming issue in the present day world. Various species are dying due to changes in their habitat which are human.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
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Hindi Mock
Group Number : 4
Group Id : 2549894474
Group Maximum Duration : 10
Group Minimum Duration : 10
Show Attended Group? : No
Edit Attended Group? : No
Break time : 5
Mandatory Break time : Yes
Group Marks : 0
Is this Group for Examiner? : No
Examiner permission : Cant View
Show Progress Bar? : No
  
  

Hindi Mock
Section Id : 2549897056
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897097
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 78 Question Id : 25498944390 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उ�� एक िहरण िदखा। ज�बाजी म� तीर िनकालते �ए
अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर ब�त दद� म� था और गु�े म� भी।
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Remington
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

Hindi Actual
Group Number : 5
Group Id : 2549894475
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 0
Group Marks : 0
Is this Group for Examiner? : No
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Examiner permission : Cant View
Show Progress Bar? : No
  
  

Hindi Typing Test
Section Id : 2549897057
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
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Question Number : 79 Question Id : 25498944546 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
प� व पि�काएं अपने अंदर तरह तरह का �ान समेटे होती ह�। इनके पाठन से �ानवध�न के साथ साथ हमारा बेहतरीन मनोरंजन भी होता है।
वैसे भी प� व पि�काएं और िकताब� इंसान की सबसे बेहतर िम� होती ह�। िकताब� और प� तथा पि�काएं पढते समय यिद इंसान इनम� एक बार
खो गया तो उसे अपने आस पास की दुिनया का खयाल ही नही ंरहता है। पाठक को ऐसा लगने लगता है िक उसे कोई खजाना िमल गया है।
इनम� छपी कहािनयो ंसे हमारा मनोरंजन होता है तो वही ंहम� नैितक �ान भी िमलता है तथा मानवीयता की समझ भी िवकिसत होती है। इनम�
कई �देशो ंपर छपे लेख व वग� और पहेिलयां तथा पदो ंके वग�जाल के अलावा बताओ तो जान� आिद सभी भाग मानव के �ानवध�न म� सहायक
होते ह�। इनम� दी जाने वाली गितिविधयां जैसे रंग भरो व िबंदु िमलाओ ंऔर किवता या कहानी पूरी कीिजए जैसे भागो ंसे बालको ंका �ान बढता
है। प� व पि�काओ ंके िनयिमत पाठन से पढने की बेहतरीन आदत का िवकास होता है। यह देखा गया है िक जो बालक पढने से जी चुराते ह� या
पाठय�म की िकताब� पढने से आना कानी करते ह� उनम� पढने की आदत को िवकिसत करने का सबसे बिढया साधन प� व पि�काएं ह�। इनम�
छपी कहािनयां व चुटकुले तथा आकष�क िच� बालको ंको पढने के िलए िववश कर देते ह�। िफर यही आदत धीरे धीरे बढती जाती है िजसे आगे
चलकर समय के अनुसार पाठय�म की िकताबो ंके पठन की ओर मोडा जा सकता है। इससे बालक म� पढने की आदत का िवकास हो जाता है
तथा उनम� पढाई के �ित �िच पैदा हो जाती है। ये प� व पि�काएं बालको ंके िलए ब�त गहराई से व धीरे धीरे काम करती ह�। कई बालक तो
कहािनयां पढने के लालच म� ही पाठशाला से िमला गृहकाय� पूरा करने बैठ जाते ह�। बालको ंतथा पाठको ंकी आयु व �िच तथा प� व पि�काओं
के �काशन की अविध के आधार पर इन प� व पि�काओ ंको कई भागो ंम� रखा जा सकता है। कुछ प� व पि�काएं पं�ह िदनो ंम� केवल एक
बार छापी जाती ह�। ऐसे प� व पि�काएं पाि�क पि�काएं कहलाती ह�। इनके नाम पराग व नंदन व स�ाट तथा चंपक और लोट पोट है। इसके
अलावा कुछ और पि�काएं भी ह� िजनके नाम चंदा मामा व स�रता और माया आिद ह�। लेिकन ये पि�काएं अिधक लोकि�य नही ंह�। कुछ
पि�काएं मािसक पि�काएं भी होती ह�। ये वे पि�काएं होती ह� जो महीने म� केवल एक बार ही छपती ह� इसिलए इन प� व पि�काओ ंको मािसक
पि�का कहा जाता है। इन पि�काओ ंम� गृहशोभा व सुमन तथा सौरभ और कादंिबनी आिद शािमल है। कुछ पि�काएं िवशेष �प से केवल या
तो मनोरंजन के िलए होती ह� या िफर केवल कई �कार की �ितयोिगता परी�ाओ ंको आधार बना कर ही छपती ह� यािन इन पि�काओ ंम� केवल
कुछ िवशेष पठनीय िवषयो ंको क� � म� रख कर छापा जाता है। इनम� खास तौर पर रीडस� व �ितयोिगता दप�ण जैसी पि�काओ ंके नाम शािमल
ह�। इनके अलावा और भी न जाने िकतने ही प� व पि�काएं दुिनया भर से संबंिधत ह� तथा वािष�क व मािसक तौर पर उनको छापा जाता ह�। प�
और पि�काएं इंसान के खाली िदमाग को शैतान का घर होने से बचाती ह�। प� व पि�काएं हमारे मानिसक िवकास का सबसे बिढया साधन ह�।
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